
Chapter 10 
Advanced Topics 
 
Introduction 
 
 
This chapter contains instructions for a variety of advanced eChalk tools.  
Additionally, you will find instructions for setting up Outlook with your 
eChalk email, integrating eChalk tools and pages into existing Websites, and 
enhancing your site by using advanced Web publishing tools.   
 
 
 
 

Using eChalk Hosting 
 
 
Web pages, documents and other files that are developed on your local 
computer may be posted to your eChalk site.  However, in order to be visible 
to your school or district community on the Internet, they must be 
transferred to a server, or Host. Your eChalk site includes a private hosting 
area that will allow you to store documents, images or Web pages on the 
Internet which you can then link to from various areas of your eChalk site.   
 
Each eChalk website starts with a default 100 MB (megabyte) storage area in 
the hosting area.   

 
Note: Please contact eChalk for more information on 
increasing your storage limit. 

 
General instructions for using your hosting area were included in Chapter 9.  
Following are instructions for specific situations that will help enhance the 
use of your eChalk system.  
 
 
 
 
 
 
 

In This Chapter 
 
•     Learn how to  use 

advanced eChalk 
tools 

•     Configure Outlook 
for eChalk email 

•     Integrate eChalk tools 
into a custom Website 
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Using eChalk Hosting         
Uploading a PowerPoint Presentation 
 
Adding a PowerPoint presentation to your eChalk site consists of three steps.  First, save 
your PowerPoint presentation as a Web page.  Next, upload the Web page to eChalk 
Hosting.  Finally, add the presentation to your homepage.  
 
 

          To save a PowerPoint presentation as a Web page: 
1 Open your PowerPoint presentation. 
2 Select Save as Web Page from the File drop down menu (available in Microsoft 

PowerPoint 2000 or higher). 
3 Click on the Publish button. 
4 From the Publish as Web Page window, click on the Complete presentation 

radio button in the Publish what? section. 
5 Select the All browsers listed above radio button (in the Browser support 

section) to ensure the widest possible audience will be able to view your 
presentation. 

6 From the Publish a copy as section, click on the Browse button and specify 
where you would like to save your presentation (e.g. in My Documents or your C 
drive). 

 Click on the Create new folder icon. 

 Enter a name for the folder (usually the same name as your presentation 
itself) and click OK. 

 
Note: When you click OK you will be inside the folder you just 
created. 

 Enter a name for the file and click OK. You will return to the Publish as Web 
Page window. 

 
7 Click Publish to publish the presentation as a Website. Wait until the presentation 

has been published. This will depend on the overall size and number of slides in 
your original PowerPoint presentation. 

8 Close the PowerPoint application. 
9 Locate the folder where you saved your presentation. Open the folder by double 

clicking on the folder icon. Inside the folder you will notice a file and a folder. 
Microsoft PowerPoint creates this file and folder automatically when you use the 
Save as Web Page option. The file is an HTML file and the folder contains all of 
the images used in the individual slides in the presentation. Remember the name 
of the HTML file as you will need to refer to it later. 

 
          To upload the PowerPoint Web page to eChalk Hosting:  

1 Log in and click on the Manage Site button located in the left side toolbar. 
2 Click the Resources button in the left side toolbar. 
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3 In the top grey toolbar, click Hosting. 
4 Click the Add Multiple button. 

 
 
 
 
 
 
 

5 Click on the Add button under Step 1 and search the directory structure for the 
files you saved to your computer. 

6 Highlight the folder that includes the PowerPoint files and the html file and click 
OK. 

7 Under Step 2, make sure the Use File Compression box is checked. 
8 Click Upload. 
9 You will be prompted to confirm that you want to upload the selected files. 
10 Click Upload again. 
11 Your files will now be saved in your Hosting area. 

       
          To add a link to the PowerPoint Web page on your site’s homepage:  

1 Log in and click on the Manage Site button located in the left side toolbar. 
2 Click the Resources button in the left side toolbar. 
3 Click the Add Resource button on the Manage Resources screen. 
4 Select Create a Link to a hosted resource and click Next. 

Note: You will need to open the folder you uploaded by clicking on 
the folder name link in order to access the HTML file.  

 
5 Check the box next to the html file that you saved. 
6 Click the Add Link button. The Link Information screen will display. 
7 Enter the appropriate information for this resource. 
8 Click the Save button. 

 
 

 
 
Using eChalk Hosting         
Uploading a Microsoft Word Web page 
 
Creating a Web page is very simple in Microsoft Word.  If you work in Word on a regular 
basis, converting documents to Web pages can be a convenient way to post information to 
your eChalk site.  You can save any document you create in Word as a Web page (in HTML 
format).  To turn a Word document into a Web page and post it to your eChalk site, follow 
the 3-part instructions below. 
 
 
 
 

IMPORTANT: After clicking the Add Multiple button, a pop-up window will display 
which asks you to run or accept an applet. You must click Yes or Run in this pop-up 
window to continue. 
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          To save a Microsoft Word document 
as a Web page (using Word 2000): 

1 Create a new folder on your 
desktop or in My Documents. You 
will save your new Microsoft Word 
Web page in this folder. 

2 Create your document in Microsoft 
Word and then select the Save As 
Web Page command from the File 
drop down menu. 

3 In the Save As dialog box, enter a proper filename. A proper filename contains 
only letters, numbers, and periods—no spaces, slashes or other characters. 

4 Save the file in the new folder you created in Step 1. 
5 Click the Save button when you are finished. 

 
          To upload the Web page to eChalk Hosting:          

1 Log in and click the Manage Site button located in the left side toolbar. 
2 Click the Resources button located in the left side toolbar. 
3 Click the Hosting link in the top grey toolbar. 
4 Click the Add Multiple button near the top of your screen. 

 
 
 
 
 
 

5 Click on the Add button in Step 1 and search the directory structure for the files 
you saved to your computer. 

6 Highlight the folder that includes the Word Web page files and click OK. 
7 Under Step 2, make sure the Use File Compression box is checked. 
8 Click Upload. 
9 You will be prompted to confirm that you want to upload the selected files. 
10 Click Upload again. 
11 Your files will now be saved in the Hosting area. 

 
       To add a link to the web page on your site’s homepage: 

1 Log in and click the Manage Site button located in the left side toolbar. 
3 Click the Resources button located in the left side toolbar. 
4 Click the Add Resource button. The Add Resource screen will display. 
5 Select the radio button next to Create a link to a hosted resource. 
6 Click Next. The Hosting area will display. 

Note: You will need to open the folder you uploaded by clicking the 
folder name link to access the HTML file. 

 
7 Check the box in front of your Web page file. 
8 Click the Add Link button. The Link Information screen will display. 
9 Enter the appropriate information for this resource. 
10 Click the Save button. 

Power Tip: It is often beneficial to convert a 
Word document to a Web page before uploading 
it to your eChalk site. By uploading a Webpage, 
you are guaranteed that others will be able to 
view the page. If you upload a Word document, 
users must have Microsoft Word on their 
computers to view your document. 

IMPORTANT: After clicking the Add Multiple button, a pop-up window will display 
which asks you to run or accept an applet. You must click Yes or Run in this pop-up 
window to continue.  
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Uploading Multiple Images for eChalk 
Pages 
 
There may be occasions when you would like to include more than one image on an eChalk 
page.  For example, on a resource page, you may have several images you would like to 
include, but the Add Image link in the resource template will only allow you to upload one 
image.  In this case, you have the option to upload additional images to the eChalk Hosting 
area and use HTML to add the images to your page.  Follow the instructions below to add 
multiple images to a page. 
 
 

          To add multiple images to a page:     
1 Log in and click the Manage Site button located in the left side toolbar. 
2 Click the Resources button in the left side toolbar. 
3 Click the Hosting link located in the grey toolbar. 
4 Click the Add button. The Add screen will display. 
5 Click the Browse button and locate the image file on your computer. 
6 Select the file and click the Upload button. The Hosting area will display 

containing your image file. 
7 Open the image file by clicking on the file name link. 
8 Highlight the entire Web address located at the top of the image window. 
9 Right click and select Copy. 
10 Paste this address into the content template using either HTML or the Rich text 

Editor image insert option. 
 
Repeat steps 1-6 as needed to add images to Hosting.  Refer to the HTML code instructions 
on page 167 to enter the image file into an eChalk content area. 
 
 

Basic HTML 
 
The information below will help you to format text entered into your eChalk pages with 
some basic HTML prompts.  HTML is the language used in Web page authoring and allows 
different browsers (Netscape, Internet Explorer) to display Web pages the same way.  Please 
note that while these prompts will help you create more visually enhanced pages, it is also 
very easy to overuse colors and other special text. 
 
In general, it is recommended to add no more than 2 or 3 colors per section (e.g. 
Announcements, Resources, or Work & Events) and to use colors that are not extreme as 
they will distract from your page instead of enhancing it.   
 
Each of these codes can be typed in the sections of your pages on eChalk where you would 
normally type or copy and paste text. 
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Basic HTML  
Manipulating Text  
 
To change text, you will need to tell the browser when you are starting and ending a 
particular text code. All codes begin with “<” and end with “>”.  In addition, all features 
need to be turned on and turned off.  Think of the text code as a light switch. The code is in 
between “<>” to turn it on and then “</>” to turn it off. 
 
 Bold <B>Type your text here.</B> 
 Italic <I>Type your text here.</I> 
 Underline <U>Type your text here.</U> 
 Center <CENTER>Type your text here.</CENTER> 
 
You can also change the size of the text. A + sign will enlarge the text size and a - sign 
decreases the size of the text.  Change the number within the “ ” to any number from 1-6. To 
make the font normal size again, be sure to turn the larger size off. 
 

<FONT SIZE=”+1”>Type your text here.</FONT> 
 
Use the <HR> text prompt to separate listed items on a page with a horizontal line.  

 
Note: You do not need to turn this feature off with the </>.    

 
You can also change to color of text.  You will also need to turn the color of your text on and 
off with prompts.  Most common color names work in this code.  
 

<FONT COLOR=”RED”>Type your text here.</FONT> 
 

Note: Use these codes sparingly. Overuse will appear confusing and 
unprofessional.  
 
 
 
 

Basic HTML  
Adding Links                          
 
If you would like to link to a Website within a text area (e.g. Announcements), 
type the following: 
 

<A HREF="Type the URL here"target=”_blank”>Type the title here</A> 
 
The “target=’_blank’” will open the link in a new window. 
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Basic HTML                  
Adding Images 
 
 If you would like to add images to a page using HTML, type: 
 

<img src=Type the image URL here> 
 

Note: In order to add images using HTML, the images must be 
hosted on the Internet.  First, add the image file to your Hosting area 
in eChalk and then open the file to access the URL. 

 
Basic HTML                  
Using a Marquee Banner                 
 
 If you would like to have text scroll across the screen (like a marquee), type: 
 

<MARQUEE>Type your text here</MARQUEE> 
 
 

Integrating eChalk Pages  
 
Schools and districts with an existing non-eChalk Web page might choose to integrate 
eChalk features such as the Calendar, Faculty & Staff directory, and Map into their non-
eChalk site.  Since eChalk tools allow for easy maintenance and updating of these content 
areas, this is an ideal way to create a cohesive and informative Web presence for your school 
community. 
 

 

Figure 10.2 

 Figure 10.1 
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In the previous example (Fig. 10.1), Dover School District has opted to create a link off of their 
customized homepage to their eChalk Calendar (Fig.10.2). 
 
Alternatively, schools and districts may need to link to specific areas or pages on their 
eChalk site from another area of eChalk.  For example, a school site may have a group page 
that they would like a direct link to straight from the homepage rather than requiring 
navigation through the Group Pages directory. 
 
In both cases, either linking to eChalk features from a custom Website or linking to eChalk 
features within an eChalk site, there are redirect links that will allow you this flexibility. 
 

 To integrate eChalk features into an external (non-eChalk) Website, use the 
following HTML coding: 

 
<a href=http://school.echalk.com/home.asp?goto=resources>Resources</a> 

 
                        Your eChalk Site Web Address                      Feature Code 
 
 

 To link to eChalk pages within an eChalk site, use the following HTML coding: 
 

<a href=http://school.echalk.com/redirect.asp?goto=resources>Resources</a> 
 
                        Your eChalk Site Web Address                          Feature Code 
 

Note:  When providing a link to an eChalk page or area from the 
Resources section of your eChalk site using the Add a link to a site 
on the Web resource type, you may use the Web links above 
without the HTML coding.  (i.e. remove the <a href= and </a> tags.) 

 
 
The feature codes for eChalk pages are as follows: 
  
  
Resources: 

 
goto=resources>Resources 

 
A specific Resource  
(not in a folder): 

 
goto=resources&pagename=Bell_Schedule>Bell Schedule 

 
Resource Folder: 

 
goto=resources&foldername=School_Information>School Information 

 
A specific Resource  
(in a folder): 

 
goto=resources&foldername=School_Information&pagename=Student 
Registration>Student Registration 

 
Calendar: 

 
goto=calendar>Calendar 

 
Faculty Directory: 

 
goto=facultystaff>Faculty Directory 

 
Profile Page: 

 
WebUserName=username>User Name 
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Class Directory: 

 
goto=classes>Classes 

 
Classes Category: 

 
goto=class_subject&dept=Science>Science Classes 

 
Class Page: 

 
goto=classes&name=Class_Name>Class Page Title 

 
Map: 

 
goto=map>Map 

 
Contact Us: 

 
goto=contactus>Contact Us 

 
AUP: 

 
goto=AUP>Acceptable Use Policy 

 
School Listing: 

 
goto=sitelist>Site Listing 

 
Groups Directory: 

 
goto=groups>View All Groups 

 
Groups Category: 

 
goto=group_category&catname=academic_departments>Academics 

 
Group Page: 

 
goto=groups&name=My_Group_Page>Group Page Title 

 
   
If you are interested in placing a log in box for your eChalk site directly on an external site, 
please contact eChalk for detailed instructions. 
 
 
 
 
Integrating eChalk Pages  
Transferring Existing Web Content to eChalk 
 
If your school already has a website and wants to continue using that content, you can store 
the pages in the eChalk Hosting area and add links to them as needed.  The process is 
similar to uploading PowerPoint presentations and Word Web pages – detailed earlier in 
this chapter.  The pages must be saved on your local computer and then uploaded to your 
Hosting area.   
 
If the content you would like to transfer to eChalk is large or you want to upload multiple 
files at once, eChalk can activate an FTP account where you can directly upload the files to 
the hosting area via an FTP client or your browser.  Please contact eChalk to arrange this for 
your school. 
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Multimedia 
 
 
Multimedia                
Rotating Image Galleries                     
 
eChalk templates allow users to add images to 
their site, including animated GIFs.   Animated 
GIFs are rotating image galleries and can be used 
to highlight events at your school, showcase 
student work, and much more.  Follow the steps 
below to create an animated GIF with Microsoft’s 
GIF Animator (for PCs only) to display on your 
eChalk site. 
 

          To format your images with Microsoft GIF Animator: 
1 Start the Microsoft GIF Animator.  
 

Note: This program can be easily downloaded for free from multiple 
providers on the Internet.  Perform a search for GIF Animator or 
contact eChalk Support for assistance. 
 
 

2 Click on the Open Folder Icon to find the first GIF image that will display in your 
animation. 

 
Note: All images must be GIF images to work within the program. 
Also, it is generally recommended that the width of image is around 
200 pixels, and its height is around 150. Larger images are harder to 
view. You can reduce the size of an image using Microsoft Paint or 
Adobe Photoshop. 

 
3 Click on the Insert button (in the toolbar) to insert each successive GIF image to 

be included in the animation. 
4 Click on the Animation tab. Select Looping, and then select Repeat Forever. This 

will set the images on a continuous looping pattern. 
5 Click the Image tab. Find the Duration speed drop-down box. This feature allows 

you to specify the amount of time, in 1/100 of a second increments, that the 
selected image displays during the animation. Adjust the duration speed to 
approximately 200 for each of the images, i.e. click on each of the frames 
individually and set each duration time. 

6 Click the Preview button to preview your work. 
7 Click the Save as button to save to your computer. 
 

 
          To display the animated GIF on eChalk:       

1 Click the Add Image link in any content template. 
2 Click the Browse button and select the animated GIF file saved to your computer. 

Power Tip: eChalk can support rich media 
components (e.g. Flash, QuickTime, Windows 
Media, Real Media).  Once you create these 
media files, contact eChalk Support for 
assistance with integrating them into your 
Website. 
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Or 
 
1 Upload the animated GIF to the Hosting area. 
2 Use HTML or the Rich Text Editor to add a link to the animated GIF.  See page 

165 for detailed instructions on adding multiple images to eChalk content areas. 
 
 
 
Multimedia                
Sound                                        
 
Adding background music is an easy way to make your homepage inviting, but remember 
not to distract your viewers from important text.  To add sound to your homepage, follow 
the 2-part instructions below. 
 
System recommendations: 
• Mac OS 8+                            
• Windows 2000 
• Internet Explorer 5+ 
 
 
Using Internet Explorer 
 

          To store the sound file:            
1 Make sure the sound file is in a WAV, AIFF, AU or MIDI format on your desktop or 

C drive and is clearly named. 

 MIDI (.mid) format gives you high quality digital sound. 

 WAV (.wav) format was developed for use with Microsoft’s Windows. The 
sound quality is not as good as MIDI, but the file is smaller. 

 AU (.au) was developed by Sun. The sound quality is poor, but the file is 
quite small, and can be used for recording short speech. 

 AIFF (.aiff) was developed by Apple for music and high quality sound. 
 
2 Click on Manage Site. 
3 Click on the Resources button. 
4 Click on the Hosting link in the top toolbar. 
5 Click the Add button and Browse through your computer to find the sound file you 

want to display. 
6 Click Upload. The file will be listed in your hosting area. 
7 On a PC: 

 Click on the file name link in the Hosting area and the music file will play in 
your default music player.      
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 Click on File and select Properties. (If you are using Windows Media Player, 
right-click the top of the player and select File > Properties.) 

 The sound file’s URL will display next to Location in the Properties window. 
Highlight and copy (CRTL+C) the sound file’s URL. 

 
8 On a MAC: 

 Click and hold on the file name. A window will appear. 

 Select Copy Link to Clipboard. 
 
 

          To activate the Sound File:  
1 Click the Manage Site button. 
2 Click on the Homepage button. 
3 Select the Announcements link. 
4 Click the Add Announcement button. 
5 In the HTML/Text box, type the following text (explained in the Notes section): 
 

<html> 
<body> 
<embed src=”/www/school/site/hosting/water.wav”hidden=”true” autostart=”true”> 
</body> 
</html> 

 
6 Remove the text in the area shaded grey and replace it with the link stored on your 

clipboard. 
7 Click Save. 
8 Log out of eChalk and go to your homepage to hear the new background music. 

 
 
Notes: 
 
• EMBED SRC tells the page to use the file of music stored in your eChalk hosting area. 
• AUTOSTART="true" means automatically play sound when document is loaded. This 

way, the sound will play as a background sound. 
• HIDDEN="true" hides the sound control console. 
• LOOP="n" This tells browser how many times to play sound. n could be an integer, true, 

or false. Setting LOOP="true", will set the browser for continuous play. 
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Multimedia                
Video                                       
 
In order to embed a looping video clip in the Announcement or Site Message section of 
your school's homepage, you must upload the video clip to your school's Hosting area and 
refer to it using HTML code.  The following instructions assume you will add the video in 
the Announcement section. 
 

       To upload a video clip to your school’s Hosting area: 
1 Log in to your account. 
2 Click the Manage Site button. 
3 Click the Resources button. 
4 Click the Hosting link located in the top gray toolbar. A list of files in your school’s 

Hosting area will display. 
5 Click the black Add button. The Add File screen will display. 
6 Click the Browse button to locate the video clip on your computer. Select the video 

clip and click Open. The name of the video clip will display in the Browse field. 
7 Click the black Upload button. A link to the video clip you just uploaded will display in 

your school’s Hosting area. 
8 Click on the video clip link displayed in the list of hosted resources. The video clip will 

open in Windows Media Player. 
9 In Windows Media Player, click on File located in the top grey toolbar and select 

Properties. A pop-up window will display the properties of the video clip. 
10 Highlight and copy (Ctrl+C) the entire link located next to Location. 
11 Click OK and exit out of Windows Media Player. 
12 Paste (Ctrl+C) this link into a blank Word Document. 

Note: You will need to refer to this link later in the instructions below. 
 

 
      To embed a hosted video clip in the Announcements section of your school’s 

homepage: 
1 Go back to your school’s eChalk site. 
2 Click on the Manage Site button. 
3 Click on the Homepage button located under Manage Site. The Announcements 

screen will display. 
4 Click the Add Announcement button. 
5 Click on the Rich Text Editor drop down menu and select No Formatting: Will display 

text & HTML as is. 
6 Paste the following HTML code into the Text/HTML box: 
 

     <P align=center><EMBED align=center src="PASTE VIDEO CLIP LINK HERE" 
width=250 height=220 type=video/x-ms-wmv autostart="true" loop="true" 
vspace="10" hspace="20"></P> <P align=center><NOEMBED></NOEMBED></P> 

 
7 Copy and paste the video clip link from the Word document in place of where you see 

PASTE VIDEO CLIP LINK HERE. 
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8 Click on the No Formatting: Will display text & HTML as is drop down menu and 
select the Rich Text Editor. 

9 Click on the black Save button when done. 
 
 
Your video clip should now display and loop in the Announcements section of your 
school's homepage when users access the school's site. 
 

 
Note: If you do not want to include a player dashboard with the Stop, 
Play, Pause, etc. buttons, you can just upload the video file to the 
hosting section and create a Resource link to it. This is just like 
hosting a regular file. When a user clicks the Resource link, he can 
open the file with his default media player or save the file to his 
computer to play later. 
 

 
 
Multimedia 
Counter          
 
eChalk provides statistical reports for homepage views upon request.  eChalk does not 
provide live counters for display on your site.  However, there are various hit counters 
available on the Internet that can be downloaded for free and then used on your eChalk site.  
Contact eChalk for suggestions.  
   

 
 
Configuring eChalk with Outlook 
 
POP3 
 
eChalk email is POP3 compliant and can be configured to be read through Microsoft 
Outlook or Microsoft Outlook Express.  The following instructions will vary depending on 
the version of Outlook you are using. 
 

      To configure Outlook with eChalk: POP3 
1 Open Outlook and select Tools from the top menu bar. 
2 Select Email Accounts from the Tools drop down menu.  The Email Accounts 

window will display. 
3 Select the Add a new e-mail account radio button and click Next. 
4 Select the POP3 radio button and click Next. 
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5 In the Email Accounts (Fig. 10.3) window, indicate the following for the Internet Email 
Settings: 

 In the User Information section, enter your name and eChalk email address 
in the appropriate fields.  

 In the Server Information section, enter your eChalk Web address (e.g. 
www.school.org or school.echalk.com) in the Incoming mail server and 
Outgoing mail server fields.  

 In the Logon Information section, enter your eChalk email address (e.g. 
user@school.org) in the User Name field and your eChalk password in the 
Password field. 

                                                             
6 Click the More Settings button.  The Internet E-mail Settings window will display. 
7 Select the Outgoing Server tab. 
8 Place a check in the My outgoing server (SMTP) requires authentication and click 

OK. 
9 Click Next. 
10 Click Finish to save your new settings. 

 
                     Note: Once your Outlook is configured to download your eChalk 

email, it is important to remember that email received through 
Outlook will no longer appear when you log in to your eChalk 
account unless you have chosen the ‘Leave a copy of messages 
on the server’ option within Outlook. If you would like to read new 
messages via eChalk when away from your school computer, 
make sure that you have not left the Outlook program open on 
your computer. 

 
 In most scenarios, you should indicate your eChalk Web address as the Outgoing mail 
server (SMTP). However, some ISPs (e.g., Earthlink) will only allow you to send mail 
through their SMTP server and your Outlook will have to be configured accordingly.  
Contact your ISP for further instructions. 

 Figure 10.3 
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IMAP 
 
If you have multiple folders within your eChalk account (e.g. Drafts, Important, Personal, 
Deleted Mail) that you would like to access using Outlook or Outlook Express, you can 
configure Outlook with IMAP.  By using IMAP you will be able to keep all of your email on 
the eChalk Web client as well as in Outlook. 
 
 
 
 
 
 

          To configure Outlook with eChalk: IMAP  
1 Open Microsoft Outlook. 
2 Select Tools from the menu at the top of your screen. 
3 Select Email Accounts from the Tools menu. The Email Accounts window will 

display. 
4 Select the radio button next to Add a new e-mail account and click Next. The Server 

Type pop up window will display. 
5 Select the radio button next to IMAP and click on the Next button. The Internet E-mail 

Settings pop up window will display. (Fig.10.4) 

 In the User Information section, enter your name and email address in the 
appropriate fields.  

 In the Server Information section, enter your eChalk Web address (e.g. 
www.school.org or school.echalk.com) in the Incoming mail server and 
Outgoing mail server fields.  

 In the Logon Information section, enter your eChalk email address (e.g. 
user@school.org) in the User Name field and your eChalk password in the 
Password field. 

 

 
 Figure 10.4 

IMPORTANT: If you delete messages from the eChalk Web client when using IMAP, 
the messages will also be removed from Outlook.  If you would like to delete messages 
from the Web client and keep a copy of the message in Outlook, configure your Outlook 
with eChalk by selecting the POP3 server type.  See page 174 for complete 
instructions.  
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6 Click the Next button then the Finish button to save the new settings. 
7 A new folder will display in your Outlook Folder List and your mail will begin to 

download. (Fig. 10.5) 
 

 Note: This is your IMAP folder. Please 
note that this is the folder where your 
emails will be downloaded.  

 
8 Right click on the IMAP folder and select IMAP Folders. The IMAP Folders pop up 

window will display. 
9 Click on the Query button located in the IMAP Folders window (Fig. 10.6). A list of 

folders that exist in your eChalk account will display. 
10 Highlight the appropriate folders into which you would like to download emails. Once 

you have highlighted the appropriate folders, click on the Subscribe button. 
 

          
            Figure 10.6 
 
11 Click on the OK button. 
12 Click on each folder to which you have subscribed to download your email headers. 

The full email will be downloaded when you double click your email to open it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 10.5 



178 Advanced Topics   Chapter 10 
 

Questions?  Contact support@echalk.com or 1-800-499-2741           

 
 


